Bravo 4202 XRP
Disc Publisher

User's Manual

PRIMERA TECHNOLOGY, INC.

© 2016 All rights reserved
For the most recent version of this manual please visit
http://www.primera.com/manuals.html
Notices: The information in this document is subject to change without notice. NO WARRANTY OF ANY KIND IS MADE WITH REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. No liability is assumed for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material. This document contains proprietary information that is protected by copyright. All rights are reserved. No part of this document may be photocopied, reproduced, or translated into another language without prior written consent.

Trademark Acknowledgments: Windows is a registered trademark of Microsoft Corporation. All other trademarks are the property of their respective owners.

Printing History
Edition 1.0, #101816, Copyright 2016, All rights reserved.

FCC Compliance Statement: This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

For Users in the United States: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Re-orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
Use of shielded cables is required to comply with the Class A limits of Part 15 of the FCC Rules. You are cautioned that any changes or modifications not expressly approved in this manual could void your authority to operate and/or obtain warranty service for this equipment.

For Users in Canada: This digital apparatus does not exceed the Class A limits for radio noise for digital apparatus set out on the Radio Interference Regulations of the Canadian Department of Communications. Le présent appareil numerique n’emet pas de bruits radioelectriques depassant les limites applicables aux appareils numeriques de la class A prescrites dans le Reglement sur le brouillage radioelectrique edicte par le ministere des Communications du Canada.

CA PROP 65 WARNING: This product contains a chemical known to the State of California to cause cancer. (California law requires this warning to be given to customers in the State of California.)

CAUTION!
TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THE UNIT TO RAIN OR MOISTURE. TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE EXTERIOR PANELS. NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL. OPERATE THE UNIT WITH ONLY THE PROPER ELECTRICAL SPECIFICATIONS AS LABELED ON THE PRINTER AND AC ADAPTER.

CAUTION!
THIS PRODUCT CONTAINS A LASER DIODE OF A HIGHER CLASS THAN 1. TO ENSURE CONTINUED SAFETY, DO NOT REMOVE ANY COVERS OR ATTEMPT TO GAIN ACCESS TO THE INSIDE OF THIS PRODUCT. REFER ALL SERVICING TO QUALIFIED PERSONNEL. THE FOLLOWING LABEL APPEARS INSIDE YOUR UNIT: CLASS 1 LASER PRODUCT LASER KLASSE 1

CAUTION!
USE OF CONTROLS OR ADJUSTMENTS OR PERFORMANCE OF PROCEDURES OTHER THAN THOSE SPECIFIED HEREIN MAY RESULT IN HAZARDOUS RADIATION.
# Table of Contents

## Section 1: Getting Started
- A. Note on Model Differences ................................................................. 2
- B. Choosing a Good Location ................................................................. 2
- C. Unpacking and Inspection ................................................................. 3
- D. Identifying the Parts ........................................................................... 4
- E. Loading Media (Discs) ........................................................................ 6
- F. Installing the Ink Cartridge ................................................................. 7
- G. Setup the Optional Kiosk Bin ............................................................... 9

## Section 2: Creating Discs
- A. Tutorial: Copy a Disc ........................................................................ 10
- B. Using PTPublisher ............................................................................ 13
  - B1. Project Types .................................................................................. 13
  - B2. Steps to Any Project ...................................................................... 15
    - Step 1: Add Data ............................................................................ 15
    - Step 2: Add Print ........................................................................... 16
    - Step 3: Start Project (Summary - Settings) ...................................... 18
  - B3. Publisher Status ............................................................................ 21
  - B4. Backup Project (PC Disc Publisher Only) ...................................... 22
  - B5. Rip Audio (PC Disc Publisher Only) .............................................. 25
  - B6. PTProtect (PC Disc Publisher Only) .............................................. 26
- C. Creating a Print Label Using SureThing (PC) .................................. 27
- D. Creating a Print Label Using Disc Cover (Mac) ............................... 28
- E. Advanced Printer Settings ................................................................. 32
- F. Printer Utilities and Cost Estimator ................................................... 35
- G. Label Design Requirements for other Graphics Programs ............. 38

## Section 3: Maintenance and Troubleshooting
- A. Interpreting the Publisher’s Indicator Lights .................................. 39
- B. Internal Blue LED Lights ................................................................. 40
- C. Transporting the Publisher ............................................................... 40
- D. Performing a Robotic Self-Test ......................................................... 41
- E. Poor Print Quality - Cleaning the Cartridge ................................... 42
- F. Technical Support ............................................................................. 47

## Section 4: Technical Specifications
- ............................................................................................................... 48

## Index .................................................................................................... 49
There are interactive features that allow you to jump to different locations within the document. Each listing in the Table of Contents is interactive. Place the cursor on either the words or the page number. A small hand with a pointing finger icon appears. Click on the line with the icon and the document will jump to that page. If you want to return to the Table of Contents, move the icon to the top of the page and click on the arrow marked TOC. Navigating to the Index (if there is one) is similar. Place the icon on one of the listings or page numbers, click on it, and it will move to that page. Returning to the Index can be done by clicking on the arrow marked Index.
Section 1: Getting Started

THANK YOU…

...for purchasing a Bravo 4200 Series Disc Publisher. Bravo is the perfect all-in-one solution for producing professional looking discs. A wide variety of disc formats are supported, including audio CDs, DVD Video, data discs and more. Operation is simple and completely automatic once a project has been started.

To begin using your Disc Publisher, please read this manual carefully. This Operator’s Manual is a complete step-by-step guide to quickly and easily create discs with your new Optical Disc Publisher.

A separate Help file is provided with your Publisher that explains the operation of the PTPublisher Software. Click the ☰️ icon in the software to access the help file.

NOTE ON TERMS AND CONVENTIONS:

From this point forward, the following terms and conventions will apply:

The Bravo 4202 Disc Publisher will be abbreviated simply as the Publisher.

Optical discs, which can include many different types of discs including CD-Rs, CD-RWs, DVD+/-Rs, BDRs and more are all referred to as CDs or discs. Please note that in order to copy and record BDRs, you will need to have purchased the Blu-ray version of the Publisher.
A. NOTE ON MODEL DIFFERENCES

The Bravo 4200 XRP Series comes in two different models including:

- Bravo 4202 XRP (2 DVD Drives) Burns and Prints CD, DVDs and DVD-DL
- Bravo 4202 XRPBlu (2 BDR Drives) Burns and Prints CD, DVD, DVD-DL, BDR and BDR-DL

These instructions are written to apply to all models. For example there are no special instructions for burning Blu-ray Discs™ if you have a Blu-ray model. The software simply recognizes that you have Blu-ray capable drives and adds the BDR media type to the list of available media to burn.

Important Note: The Blu (Blu-ray) units require a USB 3.0 port for the fastest possible burn speeds.

B. CHOOSING A GOOD LOCATION

- Place the Publisher in a location with adequate air circulation to prevent internal heat build up. If the XRP will be placed in a rack it will fit into a 7U space. The XRP is 10.75" (273.5 mm) tall which is .25" larger than 6U. In a 7U space there will be 1.5" (38.1 mm) of space above the unit. If the XRP will be rack mounted a rack mount shelf will be necessary (Part 63528).
- Do not place the Publisher near heat sources such as radiators or air ducts, or in a place subject to direct sunlight, excessive dust, mechanical vibration or shock.
C. UNPACKING AND INSPECTION

While unpacking your Publisher, inspect the carton to ensure that no damage has occurred during shipping. Make sure that all supplied accessories are included with your unit.

The following items should be included:

- Optical Disc Publisher
- Black Plastic Input and Output Bins
- Power Cord
- CMY Ink Cartridge
- Replaceable Print Head
- QuickStart Installer Disc
- USB 2.0 Interface Cable (Beige)
- Warranty Card
- This Operator's Manual, Quick Start Guide and Other Printed Information

Save the carton and packing materials. They will come in handy later if you ever need to transport the Publisher and/or any of its parts and accessories.
Front Panel and Top

This illustration shows the Bravo 4202, its Control Panel, Buttons, LED indicator lights, Input and Output Bins and other components.

The **Robotic Disc Transporter** moves discs from the Input Bin, to a CD/DVD Recorder, to the printer, and finally to the Output Bin.

The **CD/DVD Recorder** is automatically loaded and unloaded by the Publisher's Robotic Disc Transporter.

The **Recorder Tray Button** manually opens or closes the Recorder Tray. In normal operation, the in/out movement of the Recorder Tray is controlled automatically and this button is not used.
The Control Panel contains LED Status Lights and Buttons to control the Publisher. The LED Status Lights indicate that Power is ON. They also blink in certain patterns to indicate an error or other condition of the Publisher. See Section 4 for a full explanation of the LED Status Light conditions.

The **Power Button** turns the Publisher's power ON and OFF.

When the front cover is opened, the **Ink Cartridge Button** is used to position the Ink Cartridge Carrier for easy ink cartridge replacement.

The **Input/Output Bins** are situated under the top cover of the Publisher. The bins will hold up to 50 discs. The right-side bin is the Input Bin for blank media; the left-side bin is the Output Bin for finished discs.

The **Reject Area** is where discs are dropped if they do not pass a software verification test. The discs slide down the ramp out in front of your Publisher.

The **Front Cover** is a durable plastic cover that will protect the Publisher from dust and interference.

The **Ink Cartridge Carrier** holds the print head and the individual CMYK cartridges.

### Rear Panel

This illustration shows the input ports and the power switch found on the rear panel of the Publisher:

The **USB 3.0 Port** is connected to an open USB 3.0 or 2.0 port on your PC with the USB 3.0 cable, included with your Publisher.

**Note:** For maximum speeds during Blu-ray burning, your computer should have a USB 3.0 port.
The **Power Input Port** connects to the included power cable. The internal power supply is auto-switching in the range of 100-240v.

The **Power Switch** shuts off all power to the Publisher.

The **eSata ports** are only visible on Blu-ray units. You will need to connect an eSATA cable to both of the eSATA ports.

### E. LOADING MEDIA (DISCS)

**NOTE:** Your Publisher can print directly onto virtually any brand of inkjet printable-surface CD/DVD media. However, different brands of discs have different printable coatings. Because of this, you may need to adjust the printer driver settings to accommodate your specific brand of CD/DVD media. Refer to Section 2B.2 and 2E for further printer driver information.

Due to the wide variety of printable-surface CD/DVD media, you may find that certain brands of discs provide higher print quality than others. For maximum print quality, use CD/DVD media authorized by Primera.

Refer to the following steps when loading discs into the Publisher:

- Open the front cover of the Publisher
The Publisher will automatically position the cartridge carrier and Robotic Disc Transporter to the center position allowing for easy access to the bins.

Load the Input Bin (the bin located on the right-hand side of the Publisher) with 50 blank discs and place the bins on the mounting pegs.

**F. INSTALLING THE INK CARTRIDGE**

1. With the cover open, press the Ink Button (left button) to move the Ink Cartridge Carrier to the load position.

2. Open the cartridge cover by pressing down on the tab.
3. Remove the ink cartridge from its packaging. Slowly remove the tape covering the cartridge's print head.

4. Insert the ink cartridge into the carrier, copper end first and snap the cartridge cover in place.

5. Close the Publisher's front cover.

6. You will be prompted to align the cartridge in PTPublisher as soon as the software is opened. Follow the procedures displayed on screen.

Note: An alignment print is required every time you install a new cartridge. The software will always prompt you to align the cartridges. Make sure there is an unprinted disc in the bin for this alignment.
G. SETUP THE OPTIONAL KIOSK BIN

Kiosk Mode allows you to use both of the Publisher's Bins as input, doubling your disc capacity from 50 discs to 100 discs. In this mode, the finished discs will be deposited through the front "reject area" of the Publisher. In Kiosk mode all discs would be ejected in this manner. Rejects can be identified in the stack because they will not be printed. Refer to the following Kiosk Kit installation instructions. The kiosk bin is sold separately. (Part No. 63789)

To enable Kiosk Mode, OpenPTPublisher - select Options from the Tools menu - find the Options tab - now check the Kiosk Mode box. On a Mac, Kiosk Mode can be enabled in the Robot Options menu.
Section 2: Creating Discs

There are two main components to creating discs, printing and burning. For PC, SureThing CD Labeler is used to design the image to print on the disc. For Mac, Disc Cover is used to design the image to print on the disc. For Mac and PC, PTPublisher controls the recording and allows you to select the image to be printed to your discs.

A. TUTORIAL: COPY A DISC (PRINT ONLY FOR AUTOPRINTER USERS)

Note: PTPublisher functions virtually the same on both Mac and PC. Every effort was made to make them look and function the same. However, due to the unique benefits and limitations of both operating systems there are subtle differences. Where important, those differences will be highlighted. In general, these instructions will apply to both the Mac and PC editions.

There are three basic steps to any project. 1. Add Data  2. Add a Print File. 3. Set the number of copies and adjust options (Summary). The instructions below explain how to do the most common project - A Copy Project.

A Copy Project can be used to copy any CD, DVD, DVD-DL or Blu-ray master. This job type reads the master disc from the Disc Publisher drive to the hard drive of your computer. The master is stored in the Global Image format (*.gi) in a temporary location on your computer. PTPublisher uses this temporary file to make all subsequent copies that are requested. The master disc is read only once to create the initial temporary file.

Recommended for: All CD, DVD or Blu-ray content or disc types (Audio CD, Data CD, Software Install Disc, Video CD, DVD Video, Blu-ray Video: CDR, DVD-R, DVD+R, DVD-ROM, DVD+DL, DVD-DL, BDR, BDR-DL, etc.). This is best used for single runs where you will not need to make additional copies of the master disc at a later time.

This project requires a master disc. If you do not have one use another project type. (See Section 3B)
1. Select Copy Project from the Starter Window or the New Project Panel on the left side of the screen. Step one of the Copy Disc wizard will be displayed.

2. You will be prompted to place the disc you would like to copy into the drive inside the Disc Publisher. The tray door will open automatically. Place the disc in the drive and click OK.

3. The Publisher will close the drive and read the contents of the disc. It will display disc type (CD/DVD) and show the size of the disc in Megabytes. Verify this information is correct and click the next arrow to continue.

4. Select the print label file by clicking the select a label button. When you have selected a print label file, click the next arrow. There are several ways to select a print file. See the explanations below for more information.

   For any job type you choose you will be prompted to select a label file to print. You may select an existing label, create a label or choose to print nothing. Simply click the next arrow to print nothing on the disc. Otherwise follow the steps below.

4A. Select a Label

   1. Click the browse button to open a browse window to choose your print file.

   2. Double Click on the file to add it to your project. You may add any BMP, JPG, TIFF, SureThing (PC) or Disc Cover (Mac) file. SureThing or Disc Cover files are automatically formatted correctly. All other file types should be 4.72" x 4.72" square. For best print quality the image resolution should be at least 300 dpi.
4B. Create a Label

1. Click the **Create a Label** button to open the SureThing CD Labeler or Disc Cover program. These programs will allow you to create a label.

2. Follow the instructions in Section 3 D or E to create a label using SureThing or Disc Cover.

3. Once you have designed the label, save it and close the program. A message will appear asking if you would like to use the label file you just created in your current project. Click **Yes** to use it in your project. Once you choose your label a preview will be displayed.

5. After selecting your label to print it is important to check the Printer Settings. These settings are dependent upon the specific discs you are using. Each disc (media) brand or type has a different sized non printable outer margin or inner diameter. It also has a different printable surface.

For Primera TuffCoat branded discs simply choose your media from the drop down list, the settings will be adjusted accordingly.

**Inner Diameter and Outer Margin (Printable Area).**

If you have other media, you may need to measure the unprintable outer margin and the inner diameter with a clear millimeter ruler to find the correct size to input here. For the outer margin, measure from the edge of the disc to the beginning of the white printable surface. For the inner diameter measure from one side of the unprintable hub to the other. The unprintable inner diameter will almost always be larger than the center hole of the discs (15mm).
**Print Quality.** All Primera media is automatically defaulted to the best print quality. Other media may also accept the best quality setting. However, with some media you may have to print at a lower print quality to eliminate smudging and bleeding. Some lower quality media cannot hold all of the ink that is printed at the highest quality settings.

6. The third and final step of any project is the summary screen. On this screen you can review the data and print selected for the project, set the number of copies, adjust burn options and name the job. Click the Options button to access burn speed and other options. If you do not adjust the project options, optimal settings will automatically be selected for you.

Click the "Go" button to start the job.

**B. USING PTPUBLISHER**

PTPublisher allows you to record and print CDs, DVDs, and BDRs (Blu-ray) using a variety of project types described below. When the software is opened these projects will be available from the main starter menu. At any point you can access these project by clicking the project in the New Projects area on the left.

**B1. Project Types**

*Note:* “Print Only” Project is the only project available for AutoPrinters.

**Copy Project**

A Copy Project can be used to copy any CD, DVD, DVD-DL or Blu-ray master. This job type reads the master disc from the Disc Publisher drive to the hard drive of your computer. The master is stored in the Global Image format (*.gi) in a temporary location on your computer. PTPublisher uses this temporary file to make all subsequent copies that are requested. The master disc is read only once to create the initial temporary file.
Creating Discs

Recommended for: All CD, DVD or Blu-ray content or disc types (Audio CD, Data CD, Software Install Disc, Video CD, DVD Video, Blu-ray Video: CDR, DVD-R, DVD+R, DVD-ROM, DVD+DL, DVD-DL, BDR, BDR-DL, etc.). This is best used for single runs where you will not need to make additional copies of the master disc at a later time.

This project requires a master disc. If you do not have one use another project type.

Data Project

A data disc project allows you to create a data disc on a CD, DVD or BDR using files on your hard drive. You can replicate the file structure on your hard drive or you can create your own customized file structure.

Recommended for: Creating software installation discs, or data discs containing image files, presentation files, PDFs, documents, MP3s or any other file type. Data discs can generally ONLY be read by computers.

Audio Project

This project allows you to create an audio CD using WAV, MP3, AIFF or WMA files. Note: this procedure is not for copying already created and mastered original audio CDs. If you have already created a master audio CD in another application or this application and you would like to make additional copies, please use the Copy project.

Recommended for: Creating Audio CDs.

Video Project

This project involves extracting the Audio_TS and Video_TS folders from the master DVD or directing your DVD authoring software to output into Audio_TS and Video_TS folders instead of burning a master disc. For Blu-ray Video, this method involves extracting the Blu-ray folders from the master DVD or directing your Blu-ray authoring software to output into Blu-ray folders instead of burning a master disc. Note: The PTPublisher software was not meant for authoring DVDs or Blu-ray. You must use another software to burn a master DVD first. Make sure that disc plays and the menus work on all systems. You may also copy a master DVD using Copy Project or Image Project. However, the video project is the recommended method since it is faster and more reliable.
Recommend for: Situations where you are having compatibility problems with the formatting created by the DVD/Blu-ray authoring software or with the media type of the master disc. This method removes some potentially complicating variables from the DVD/Blu-ray Video creation process. This method eliminates the need for a master disc. Error or incompatibilities can be introduced into your master by the drive burning the master, the disc the master is burned on or the software burning the master. Instead masters can be stored on a large hard drive. This allows you to burn additional copies at any time without locating the master. If a backup strategy is employed, hard drive storage is more reliable over the long term since it is not susceptible to scratching like a master disc.

**Image Project**

The Image Project allows you to copy any CD, DVD, or BDR master. A disc image is an exact copy of your disc that you can save on your hard drive for later use. You can use an existing image or create an image and then use it in the project. The master disc is read from the specified drive to the hard drive of your computer. The master is stored in the Global Image format (*.gi) in a user specified location on your computer. PTPublisher uses this file to make all subsequent copies that are requested. The master disc is read only once to create the initial file.

Recommended for: All CD, DVD or Blu-ray content or disc types (Audio CD, Data CD, Software Install Disc, Video CD, DVD Video, Blu-ray Video: CDR, DVD-R, DVD+R, DVD-ROM, DVD+DL, DVD-DL, BDR, BDR-DL, etc.). This is best used for jobs that are repeated on a regular basis where you will need to make additional copies of the master disc at a later time. This project type stores the master on your hard drive. This saves the time it takes to read in the master and reduces the possibility of defects being introduced into the master disc.

**B2. Steps to any Project.**

**Step 1: Add Data**

Depending on your job type this step will be different. You may choose your master, choose data on your hard drive, choose tracks to your audio CD, choose your disc image or DVD or BDR video folders.
On most job types a volume label can also be created at this step. This is the label that will appear when this disc is inserted into a computer drive.

When you have selected the data you would like to burn click the next button.

**Step 2: Add Print**

If you want something printed on your disc, this is where you choose an existing label or create it. Follow these steps.

**To Select an exiting label:**

1. Click the browse button to open a browse window or drag and drop files to the print file box or click the drop down arrow to choose previously used labels.

2. Choose any supported file types of JPG, BMP, TIFF, SureThing (PC), or Disc Cover (Mac). Files should be 4.72" (120mm) square. For best print quality the image resolution should be at least 300 dpi. Non-conforming files will be stretched or increased in size to fill the full size of the disc.

3. Once the print file is selected a preview will be displayed.
4. At this point you may choose to move on to the next step by clicking the next arrow. However, there are print quality and print area settings that you may want to adjust.

5. Several preset media types that correspond with the media available at our webstore can be selected from the Media drop down box. When you select a media type from this box the Print Quality, Outer Margin and Inner Diameter are automatically adjusted to fit that media.

6. To manually set these settings simply edit them. The media type will automatically change to Custom. You can save your adjusted settings by typing the name of the profile and clicking Save. This name and the associated settings will now be available to choose in the media drop down box.

Below is a description of each of the available settings.

- **Quality.** There are several choices here that correspond to the speed of the print and the saturation of the image. Higher quality = slower print speed and more vibrant and crisp prints.

- **Outer Margin.** Discs from other manufacturers vary widely regarding how far the printable surface extends to the edge of the disc. Measure the distance from the edge of the disc to the start of the white printable area. This will be between 0 and 2 mm in increments of 0.1 mm.

- **Inner Diameter.** Discs from other manufacturers vary widely regarding how far the printable surface extends to the inside of the disc. Measure the distance from one side of the inner unprintable center hub to the other. This will be between 15 mm and 50 mm displayed in increments of 0.1 mm.

**To Create a new label:**

1. Click the Create Label button.

2. The label design application SureThing (PC) or Disc Cover (Mac) will open.

   Design your label using the included backgrounds and clipart. You may also add your own image. Add text and any other design features.

3. Save your label by going to the File menu - Save as.
4. Close SureThing or Disc Cover.
5. You will be asked if you would like to use the label you just created in your current project. Click Yes.
6. You may now choose to adjust print settings as described above.

**Step 3: Start Project (Summary - Settings)**

In this step you can verify data and print information and set the number of copies. Optionally you may choose to edit burn settings. However, the default settings are optimized to give you the best quality burn. Simply click “Go” to start the job.

Below is a summary of all available options:

**Project Summary**

This areas displays information about the data you have chosen, a thumbnail and file name of the print file you have chosen and picture and description of the Disc Publisher Robot you have chosen. If any of this information is incorrect, use the back arrow at the bottom of the screen to go back to the appropriate window to correct it.

- **Change Robot.** This is only available with multiple robots connected. Click it to change the robot to which this project will be sent.

- **Drives.** With multiple drive units connected you can choose to burn to both drives or only the top drive or only the bottom drive. This is useful if one of the drives is starting to wear out and is producing rejected discs. You can simply stop using that drive until you are able to replace it.

- **Protect Video with PTProtect (PC Only).** This is only available in the DVD Video and ISO image Project with purchase of PTProtect USB dongle. See the PTProtect Section 3B.6 for more information.

- **Save Project.** On a Mac, at the top of the summary window you can type the name of your job and then click save to save it anywhere on your computer. For PC, you can save a project at any time by opening the file menu and choosing Save Project.
A project file is a small file that holds the locations of files to be burned, the location of the print file to be printed, and any specific project settings such as burn speed and number of copies. Note: A saved project file does not include the data to be burned or the print file to be printed. If these files are moved or deleted, the project file will need to be edited to reflect these changes.

- **Schedule Project.** Click this button to schedule this job to run daily weekly or monthly at a specific time. For more information on this topic see Section 3B.5.

**Project Options**

For any job type you can click on the Options button for additional options for that job. Below is a description of all Project Options. Not all options are available for all Project Types. If the options are not available for the chosen project type, they will be hidden. If you would like these settings to be the default for all projects of this type click "Save as Defaults".

- **Recording Speed.** Set the recording speed with this option. The fastest recording speed is determined by the lowest maximum speed of the blank media or the drive. For example: The "fastest" speed in a 20x max drive with 16x max media would burn at 16x. In many cases a slower speed should be selected to achieve the least number of rejected discs.

- **Recording Type.**
  
  *Track-at-Once.* This is the default. For track at once, the laser is turned off after each track, which produces a two-second gap. The track-at-once feature, enables songs and data to be written at different intervals. The lead-in sectors that are written at the beginning of each session contain the location where additional data can be placed on the disc.

  *Disc-at-Once.* If this option is checked, the lead-in, all the tracks and lead-out are written in same action. The laser is kept on for the entire session.

- **Closed-Finalized/Open.** A closed disc means no additional data can be added. If the disc is left open additional data can be added in another session.
• **File System.** The file system is the method by which the files and folder are arranged on the burned disc. Joliet is best for most CD burning applications. UDF 1.02 is best for DVD burning. UDF 2.6 is used for Blu-ray. The recording engine can also add a bridge which effectively adds another file system to the disc. UDF1.02 with a Joliet bridge is the default.

Most of the differences between file system types relate to file name length and character restrictions and folder level depth. ISO is the most restrictive and oldest and UDF is the least restrictive newest file type. The complete list of specifications for each is several hundred pages. Macs and PCs can read both types.

If you would like to make your burned disc compatible with very old operating systems or other less popular operating systems use the ISO system.

• **Test Record.** If this option is checked the recorder tests a disc for record ability before burning. The drive laser is set to read power and the entire surface is scanned for errors. This takes the same amount of time as recording. (DVD+R media cannot be tested) This option cannot be used in combination with normal recording or verify.

• **Verify.** If this option is checked, it compares the copy with the master bit for bit. If it finds a discrepancy it rejects the disc. Verify is an extremely high quality standard. If the disc is audio or video, the disc may still be playable and the errors may not be detectable by human eyes or ears. This operation may be useful to verify software installation discs where it is extremely important to have accurate copies of all installation files. Checking this option will double the time it takes to record each disc.

• **Set Time and Date to Mastering Time.** If this option is checked, all files on the disc will automatically be set to the current time and date.
B3. Publisher Status

The status window is automatically displayed when a job starts. You may also access it at any time by clicking the More Status link under the picture and description of the robot connected. Publisher Status is only available if the Publisher is connected.

- If no errors are present, the green check button will be displayed with a Ready indication to the left.
- If errors are present a red exclamation button will be displayed with the error explained to the right. At times the entire error will not be visible. Click More Status to view the complete error.

The Status page displays Drive Status, Printer/Robot Arm Status, and Project Status.

Drive Status shows the current status of the drive during a job. The recording progress is displayed on the progress bar along with the total size of the burn and the current amount burned.

Printer/Robot Status shows the current status of the printer if it is printing or the robot if it is moving discs.

The Project Status area of the Publisher Status window shows the current status of the job such as what disc number is printing and burning of the total number of discs to produce. From here you may also view a detailed log of the current job, view a log of previous jobs and abort currently running jobs.

To abort a currently running job, click the abort button. The publisher will finish its current robotic command and then stop the job.

Queue Project. To queue another project to run after the current one is finished simply setup the project as you normally would. When you get to the third step of the project setup wizard, if a project is currently running a Queue button will appear instead of a Go button. Click it to queue the job.
B4. Backup Project. (PC Disc Publishers Only)

To create a new backup project you must setup a data project and then schedule it. Follow these steps:

1. Choose Data Project from the project starter window.
2. Add the files or folders that you would like to backup. Typically there will be more data to back up than will fit on any one CD, DVD etc. If that happens you will receive a warning message and the data bar at the bottom of the screen will turn red.

To resolve this issue you may choose to span the data over several CDs or DVDs or change the media to a different type with more data capacity.

If you choose to check the span disc box you do not need to change media type. A Span Report button will appear which will tell you how the data will be distributed over the chosen media type.

Regardless of the media type selected for back up projects it is recommended that span discs be checked to accommodate future backups of the same files/folders which may be larger.

**Important Note:** It is not possible to span a single large file over multiple discs.
Using the media drop down list, you may also choose to change the media type to one with more capacity. The data bar will change from red to green.

![Media Drop Down List](image)

**Note:** Changing the media type only changes the media that the software expects. It is up to the user to make sure the selected media is actually in the bin.

3. Once you have selected the data click the next arrow to add a print file. There is a print template that has been designed for backup projects. It is recommended that this template be used. Check the "Use Print Template" box.

![Print File Template](image)

Title and description fields will appear below it. Fill out these fields with information pertaining to the backup project. Date, time and the number of discs in the backup set will automatically be printed on the disc. Click the refresh button to view your changes in the preview.
4. Click the next button to display a summary of the project. Click Schedule Project to convert this data project into a backup project. You will be prompted to save your project. Do not move projects once you have saved them. Always choose only one copy even if your project will be spanned across multiple discs.

Once the project has been saved the Schedule window will appear. Set the frequency of the backup and the time of day. Click Schedule.
The Scheduled Projects window will appear. Check the box next to the backup project you would like to run. Click Run Now to run it for the first time now. Otherwise, the backup project will proceed at the scheduled time.

You must keep the PTPublisher software open, the Disc Publisher turned on and the discs loaded for the automatic scheduled backup to occur. If you would rather not do this you may also check None on the Schedule window to run the backup project when you choose. This will add the backup project to the Scheduled Projects list and allow you to run it whenever you click the Run Now button.

You can access the Scheduled Projects list at any time by choosing Advanced Project from the project starter window. Choose Backup Project from the sub menu. Here you can view all scheduled projects, edit the project or change the frequency or time of the automatic backup.

**Note:** All backup runs are full backups. PTPublisher does not do incremental or differential backups by searching for new or changed data.

**B5. Rip Audio CD (PC Disc Publishers Only)**

This project allows you to rip music to your hard drive in MP3 or other formats using iTunes® or Windows Media Player.

1. To rip an Audio CD to your iTunes database or Windows Media Player database choose Advanced Projects - Rip Project.
2. Choose whether to rip to iTunes or Media Player.
3. Load the blank CDs in the right bin of the Disc Publisher.
4. Click Go to start ripping CDs. Follow any onscreen prompts regarding settings that must be set before you begin.

**Note:** The actual ripping process is completed by iTunes or Media Player. Please set all settings regarding the rip format (mp3, wav, wma, etc.), rip location, rip quality (kbps), etc. in Media Player or iTunes.
B6. PTProtect (PC Disc Publishers Only - Requires separate purchase of USB dongle)

PTProtect allows you to copy-protect any DVD Video and mass produce protected discs using the PTPublisher software and a Primera Disc Publisher.

You can protect an existing Master DVD by first converting it to an ISO image using PTPublisher or you can protect a DVD that is stored on your hard drive as VIDEO_TS and AUDIO_TS folders. Instructions for each of the two methods are found in the instructions with the PTProtect dongle or in the PTPublisher software help file.

To protect DVDs you must first insert the PTProtect USB Dongle (100, 250, 500, 1000 or 5000 protections) into a USB port on the same computer that the Disc Publisher is connected to. Once you insert the dongle it will appear in My Computer as the next available drive letter with a Volume Label as "PTProtect."

When PTPublisher is launched the PTProtect option will be enabled. The number of protections enabled will be visible on the Summary screen (Step 3) of the DVD Video Project or Image Project.

Note: You will receive 3 free protections before the USB dongle is purchased/connected. After the free protections are used the PTProtect option is still visible but not selectable.
C. CREATING A PRINT LABEL USING SURETHING (PC)

The SureThing Disc Labeler software included with your Publisher is a great tool for creating professional looking discs. You can use SureThing’s Smart Designs to quickly label a disc, or easily import your own design in many popular file formats. The Help section included with the software will provide complete instructions on all the features in this package. (Go to the Help Menu - Choose Contents) The following is a tutorial on creating a basic disc design:

1. Open the SureThing program. Choose the 120mm Disc Template from the window that appears.

2. Open the background panel by clicking the arrow on the background button. Add your own background to the label by choosing Select Background.

3A. Browse to the location of your background image. To avoid skewed or blurry printing make sure your image is 120mm square and of sufficient resolution. We recommend 300 dpi.

3B. Instead of your own background, you can also choose from several included SureThing backgrounds. To choose one of these images click the SureThing Background button in the Browse window that appears when you click Select Background. Also, you can easily toggle through the backgrounds by using the toggle bar below the label (pictured below).
4A. Open the text panel by clicking the arrow on the text button. Add text by selecting one of the options below. To create text that follows the curve of the disc choose Add Circular Text.

4B. You may also choose from several SureThing smart designs. These design templates automatically position your text and use certain text effects to give your label a professional look. You can easily toggle through smart designs by using the middle toggle button on the toggle bar below the label.

5. Finally, open the picture panel by clicking the arrow on the Pictures/Clipart button. Add any logos, graphics or symbols to the label. These graphics will appear on top of the background image. You can size them appropriately by dragging the corner of the selected graphic.

6. When you have completed design work save your label by choosing Save Project in the Actions panel.

D. CREATING A PRINT LABEL USING DISC COVER (MAC)

The Disc Cover Disc Labeler software included with your Publisher is a great tool for creating professional looking discs on a Mac. You can use Disc Cover's backgrounds and clipart to quickly label a disc, or easily import your own design in many popular file formats.

The Help section included with the software will provide complete instructions on all the features in this package. (Go to the Help Menu - Disc Cover PE Help) The following is an overview of the basic components of the software:
1. Open the software by clicking the Create Label button on the Add Print File step of PTPublisher. There is no way to open Disc Cover PE outside of the PTPublisher software.

2. To add a background from Disc Cover, click the Gallery button on the top tool bar. On the image above, the Gallery button is the highlighted center color wheel button on the left side of the top tool bar.

3a. Choose Backgrounds from the drop down box. Click the design that you would like as your background. Use the scroll bar to view all of the designs.

3b. You may also select an image or design from your hard drive as long as it is a supported file type such as tiff, jpg, bmp or pdf. Go to the Insert Menu - Select Image - Choose From File…
4. Once your image or background has been selected you can add text or other design elements using the buttons on the tool bar or the Inspector. Below is a short description of each of the important buttons.

- **Import** - Import song titles from iTunes or pictures for a collage from iPhoto.
- **Gallery** - Choose a Disc Cover background or several backgrounds to make a collage. Create your own backgrounds and add them to the Gallery.
- **Clipart** - Choose from a wide selection of categorized clipart. After selecting this button, click the dropdown that appears to see all categories.
- **Selection** - Resize or move text, images or shapes with this tool.
- **Text** - Create a standard text box.
- **Circular Text** - Create circular text that follows the contour of the outside or inside of your disc.
- **Zoom** - Zoom out or in.
- **Color** - Change the color of the selected object with this tool.
- **Font** - Change the font of the selected text or circular text object with this tool.
- **Inspector** - Click this button to open or close the Inspector window. The Inspector window includes advanced options that allow you to change the properties of your template, change size or position of the objects, add effects, edit transparency, change text properties and align objects. See the next step for more information.
6. Once you have several objects on screen you may choose to use the Inspector tool to edit advanced object properties. Select the objects you would like to edit and then click on one of the six buttons on the top of the inspector. Four are shown below. See the description of each to understand what options are available on each.

- **Design Element** - Switch to a new template, edit the current template, create your own.
- **Geometry** - Precisely move, resize or rotate selected objects.
- **Fill and Shadow (not shown above)** - Add shadow, change thickness or color of geometric objects.
- **Image (not shown above)** - Add transparency or a gradient to images, clipart or backgrounds.
- **Text** - Change line spacing, character spacing, fonts, size, or justifications of any selected text object.
- **Alignment** - Align or distribute multiple text objects.

7. Many other options such as changing the order of objects, (send to front, send to back) and exporting in other file formats are available from the Disc Cover menus which is visible at the top of the screen when the Disc Cover application is open and has focus.

8. Finally, save the design by going to the file menu - save as. Quit Disc Cover by choosing Quit from the Disc Cover PE menu. PTPublisher will ask you if you would like to use the design you just saved in your project. Choose Yes.
Advanced Printer Settings can be accessed from the Add Print File Step in either PTPublisher for Mac or PC. All available settings are displayed in the Printer Settings area on this screen.

Below is a description of each.

**Print Quality**

This setting affects the quality and speed of the print. Ink consumption is only slightly increased as you increase the quality. The default setting of medium is sufficient for most images. If you are printing large areas of solid color you may find that you must increase the quality to reduce banding.
Saturation

This option controls the ink saturation of the printed image. When printing onto the printer manufacturer’s TuffCoat media, this option can be left at its default setting of 100%. When printing onto other brands of printable media, you may need to adjust this control in order to optimize the ink saturation for the printable surface of your specific media. Click on the up and down arrows to change the ink saturation setting. Lower numbers reduce the overall ink saturation, while higher numbers increase it. If discs do not seem to be drying completely it may be necessary to reduce this value.

Outer Margin

Adjust this value to print all the way to the outer edge of a disc. This is useful if you are printing full coverage images. The lower you set this value the farther to the outer edge of the disc you will print. Please note that with most media the printable surface does not extend all the way to the edge of the disc. Because of this you will not normally set this value to zero. You may also want to adjust the inner diameter setting. To use the preset outer diameter setting for Primera media, select the media type from the drop down box at the top of the printer settings area.

Inner Diameter

This value changes the size of the non-printed center. Larger numbers cause the non-printed center to be larger and smaller numbers make the non-printed center smaller. This number is incremented by 0.1mm so a change of 10 for inner diameter changes the diameter by 1mm. Set the diameter to 230 for Primera TuffCoat media. To use the preset outer diameter setting for Primera media select the media type from the drop down box at the top of the printer settings area.
Color Mode

*Best for Graphics* mode is best used for graphical images where accurate color reproduction is not as essential. Images printed in this mode will look more vibrant because more ink is being used to produce them. However, printing images of people may produce skin tones that have a reddish tint.

*Best for Photos* mode is best used for photographic images where accurate color reproduction is very essential. Images printed in this mode will look lighter than those printed in Photo mode. Skin tones especially will look more natural in this mode.

**NOTE:** Exact color matching of the printed discs to the screen may never be possible since there are factors that affect this out of the drivers control. The surface of the disc reacts with the ink in the cartridge to produce the color. For this reason, when printing the same image to different types of discs with different surfaces the printed output can look entirely different.

Printer Tools

Click this button to open the cost estimator, and printer utilities window (Section 2F).
The printer utilities and the cost estimator can be accessed by double clicking the ink levels in the lower right corner of the screen or by clicking the Tools Menu - Printer Properties.

Cost Estimator

After printing one disc of any design the Cost Estimator can be used to estimate the cost per discs. Ink cost is automatically and continuously calculated based on the color cartridge costs entered. Only the last printed label cost is displayed. For reference, the print file and date of last print is displayed as well.
• You will need to Set the Cartridge Cost first before receiving a cost per disc. Adjust the cartridge costs according to the actual price paid. The estimate does not take currency into account so you can assume that whatever value you entered is displayed in your currency.

• Save a screen capture of the cost by clicking the disc icon.

• Print a screen capture of the cost by clicking the printer icon.

**Important Note:** The cost per disc represents the average cost per disc over an entire run of labels. This means that the per label cost will decrease and become more accurate as the number of labels printed increases. This is because the ink that is used for initial job starting cartridge maintenance is divided into a larger number of labels.

**Calibrate the Disc Publisher**

Several advanced calibrations can be performed with this utility. Under normal circumstances you would have no reason to perform any of the calibrations since all of them are factory calibrated. However, if the Disc Publisher is having trouble picking from any location, the calibrations available here can be used to correct this problem.

**Align Cartridge**

The Cartridge Alignment prints a test print and then automatically scans the print to configure your printer for bidirectional printing. It is important to perform this calibration every time you change a cartridge. If you forget to perform this calibration you will be prompted to do so before your first print from the new cartridge.

**Center Print Image**

**NOTE:** Your printer comes from the factory pre-calibrated to print the image to the center of the CD. You can use this adjustment if you need to fine-tune this location.

If you ever wish to verify your factory-calibrated Vertical and Horizontal calibration settings, you can run a simple calibration procedure to assure that your images will be centered when printed on a CD. To do this, refer to the following steps:
1. Click Center Print Image in the Printer Settings Window.

2. Click Start Auto Calibration to begin printing the calibration test print.

3. When the print is complete, rotate disc 180° and put the disc back in the input bin and repeat step 2 using the same disc.

4. When the second run of the print is complete, you should have a test print that looks similar to the following:

5. Along the Vertical axis of the printed disc, find the number whose lines touch. For example, in the above illustration, Enter the number 2 into the Vertical box of the Calibration window and 0 for the Horizontal axis.

6. Select the OK button. Your images should now be centered when printed on a disc.

Note: If you think you know what values to enter for the horizontal and vertical fields you may skip the Auto Calibration and enter the values directly by clicking Manually Set Values.
Change Cartridge

Select the Change Cartridge button to install a new ink cartridge or to switch back and forth between previously used cartridges.

Clean Printhead/Cartridge

If the printer has been idle for a long period of time you may start to experience some drying of ink in the tiny nozzles that make up the print head. Clicking this button will cause the Publisher to pick a disc and place in into the printer tray. The Publisher will then print a simple pattern that will flush ink through the nozzles. **Multiple cleaning prints may be necessary!** If the nozzles are not fully clear after a few cleaning prints, it may be necessary to remove the cartridge and manually clean the print head. See Section 3D.

---

**G. LABEL DESIGN REQUIREMENTS FOR OTHER GRAPHICS PROGRAMS**

Other graphics programs can be used to design labels and print directly to the Publisher.

When printing and burning through the PTPublisher software your Publisher will support the following additional standard label image file formats: BMP, TIF, JPG, GIF, PNG and PRN. These formats can be exported from most original graphics formats such as Adobe Photoshop or Illustrator.

When creating images in other graphics programs we recommend creating a 4.72 x 4.72 square image that has a 300 dpi resolution.
Section 3: Maintenance and Troubleshooting

The Publisher is designed to operate for extended periods of time with very little attention. In fact, no regular maintenance is recommended other than cleaning the outside case.

**NOTE:** Do NOT attempt to oil or grease the Publisher’s Robotic Arm shaft or other components. You will likely cause more harm than good! Any moving parts are designed to operate for the life of the machine with no additional lubrication required.

### A. INTERPRETING THE PUBLISHER’S INDICATORS LIGHTS

The Power and Busy LED indicator lights located on the top of the Publisher can tell you a lot about what is happening inside the Publisher. To accurately interpret what it means when these lights are on, off, or flashing, please refer to the following:

<table>
<thead>
<tr>
<th>Ink Cartridge LED</th>
<th>Power LED</th>
<th>Publisher</th>
</tr>
</thead>
<tbody>
<tr>
<td>off</td>
<td>on solid</td>
<td>Is ready to receive job</td>
</tr>
<tr>
<td>on solid</td>
<td>on solid</td>
<td>Has received a job and is waiting for the Robotic Disc Transporter to load a disc</td>
</tr>
<tr>
<td>both lights are <strong>slowly</strong> blinking alternately with one another</td>
<td></td>
<td>Waiting for a cartridge to be installed and the lid to be closed (See Section 2-A)</td>
</tr>
<tr>
<td>both lights are blinking alternately followed by only the left light intermittently blinking for approximately 30 seconds</td>
<td></td>
<td>The Publisher is initializing. You will see this pattern when the Publisher is first turned on. Wait until the lights stop blinking before opening software or starting jobs.</td>
</tr>
<tr>
<td>flashing rapidly on solid</td>
<td></td>
<td>The printer tray or ink cartridge carrier has stalled. Press the Ink button to retry the operation.</td>
</tr>
</tbody>
</table>
B. INTERNAL BLUE LED LIGHTS

The Publisher’s Internal LED lights provide useful light and also can provide status information.

By default, the lights are set to Flash Enabled. This condition will flash the internal LED lights off and on during any error condition.

- A Low Ink Warning error will slowly dim the LED lights.
- A flashing LED light indicates a general system error that needs attention such as a missing ink cartridge, out of discs or a mispick. Refer to the PTPublisher software for instructions on how to correct the problem.

The following internal LED light states can be selected in the PTPublisher software.

- Flash Enabled (Default) - Errors are indicated in the manner described above.
- Always On - No errors are indicated.
- Always Off - No errors are indicated.

To access these settings on a PC go to the Tools Menu - Options. To access these settings on a Mac go the the PTPublisher Menu - Preferences.

C. TRANSPORTING THE PUBLISHER

To prevent damage to the Publisher’s robotic arm during shipment, it is important to properly secure it.

To prepare for transport, remove the ink cartridges and disc holders, close the front cover and then do the following:

1. With the front cover closed, switch off power to the unit.
2. Press and hold the Cartridge Button.
3. While continuing to hold the Cartridge Button, switch on power to the unit.
Continue to hold the Cartridge Button for five seconds. After several more seconds, the robotics will undock and the arm will lower. Power will shut off automatically once the robotics are in transport position. If you have the cardboard spacer that was shipped with the unit, replace the spacer inside the unit and close the cover. If you don't have the cardboard spacer, secure the arm and cartridges to the sides of the unit with tape and close the cover.

D. PERFORMING A ROBOTIC SELF-TEST

To ensure that everything is working properly, a Self-Test feature is built in to your Publisher. In this mode, the Robotic Disc Transporter will go through the motions of picking and placing a disc to ensure proper working order. This test may be performed without connecting the Publisher to the PC.

Perform the test by doing the following steps:

- Load some discs into the Input Bin
- Open the TOP DRIVE by pressing the eject button on the drive.
- The cover must be closed for this operation to complete.

However, in order to access the buttons you must open the cover. To get around this problem simulate closing the cover by activating the cover lock sensor. You may do this by putting an object such as a folded piece of paper in the slot where the lock would normally be located.

- With the Publisher turned on, press the Cartridge Button
- While holding the Cartridge Button, press the Power Button until the robotics start to move.
- Release both buttons
- To stop the test, wait until the disc has moved to the Output Bin and press the Power Button.
E. POOR PRINT QUALITY - CLEANING THE CARTRIDGE

It may be necessary to clean the ink cartridge nozzles if you notice reduced print quality, or if you suspect a cartridge nozzle has become slightly dried out or clogged. If the cartridge has been left out of the printer more than 30 minutes, the ink in the printhead nozzles may have dried. If you are having print quality problems, follow the steps below:

1. Before moving on to the next step, ensure that the Ink level of color cartridge is more than 10%. If ink level is lower than 10%, replace the cartridge.

2. Try cleaning the printhead using the clean printhead / cartridges function on the printer tools window. This can be accessed by double clicking the ink levels in the lower right corner of the screen or by clicking the Tools Menu - Printer Properties.
3. Determine if printing is now acceptable
   - After the printer has completed cleaning the cartridge, a sample will be printed.
   - If the sample has missing colors or voids within a color strip, remove the printhead from the printer and proceed to step 4.

4. Prepare items needed for procedure.

   **Good Print**
   
   ![Image of a good print sample]

   **Bad Print - Missing Cyan**
   
   ![Image of a bad print sample missing cyan]

Two Paper Towels
folded four times each

A Glass of Water
5. Soak the paper towels in water for 5 seconds. 

*Note:* Do not squeeze water from paper towels after removing from water.

6. Place one paper towel on printhead nozzles.
7. Wipe printhead nozzles.

Remove paper towel from printhead nozzles and discard.

Place second paper towel on flat/hard surface. Firmly press printhead nozzles into paper towel and drag printhead in the direction indicated.

After wiping the printhead nozzles, the paper towel should show all three colors.

If all three colors are present, proceed to step 8.

If the paper towel doesn't show all three colors, then repeat step 7.

If paper towel still doesn't show all three colors repeating step 7, then replace the cartridge.

8. Dry printhead.

Dry excess water from printhead. Ensure printhead contacts are completely dry. Printer damage may result if printhead contacts aren’t completely dry.
9. Clean the printhead using the clean printhead/cartridge utility.
   - Reinstall printhead.
   - Access the printhead/cartridge clean function described in step 2.
   - To insure all water has been removed from the nozzles, repeat this step twice.
10. Verify printhead is now functioning properly by repeating the print assessment described in step 3.

- After the printer has completed cleaning the cartridge, a sample will be printed.
- If the 2nd sample has missing colors or voids within a color, purchase a new color cartridge.

F. TECHNICAL SUPPORT

If you have difficulties operating your Publisher, the procedures in this manual and the software User's Guide should, in most cases, solve the problem. If you still have difficulty, contact the technical support via one of the methods listed below.

<table>
<thead>
<tr>
<th>Source</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primera Knowledge Base</td>
<td><a href="http://www.primera.com/kb">www.primera.com/kb</a></td>
</tr>
<tr>
<td>PTPublisher Software Help files</td>
<td>Open the software. Click on the 🎯</td>
</tr>
<tr>
<td>SureThing Software Help files</td>
<td>Open the software. Click on the Help Menu - Contents</td>
</tr>
<tr>
<td>Email Support</td>
<td><a href="http://www.primera.com/contactsupport">www.primera.com/contactsupport</a></td>
</tr>
<tr>
<td>Phone Support</td>
<td>763-475-6669 (Mon - Fri 8 a.m. - 6 p.m CST)</td>
</tr>
</tbody>
</table>
## Section 4: Technical Specifications

- **Model**: Optical Disc Publisher 4202 XRP
- **Configurations**: Blu-ray Publisher, DVD+/ -R-CDR Publisher
- **Printing Method**: Inkjet
- **Printing Resolution**: 4800 x 1200 dpi, 2400 x 1200 dpi, 1200 x 1200 dpi, 600 x 600 dpi
- **Ink Tank**: Single CMY cartridge
- **Maximum print width**: 4.724" (120mm)
- **Minimum PC System**: Intel Pentium IV Processor or higher, 1GB RAM or higher, 10GB or more free hard drive space, available USB 2.0 or 3.0 port.
- **Minimum MAC System**: Intel CPU running OS X version 10.7 or higher, 1 GB RAM, Free hard drive space of at least 10 GB
- **Disc Capacity**: 50 disc input, 50 disc output (default), 100 disc input, 100 disc output (Kiosk Mode)
- **Operating Systems**: Window 7, 8 and 10, Mac OSX Version 10.7 or higher
- **Interface**: USB 3.0 port
- **Power Requirement**: 100-240VAC automatic switching, 4.5-2.5A, 50/60Hz
- **Weight**: 40 lbs. (18.14 kg)
- **Dimensions**: 17.5"W x 10.75"H x 16.15"D (445mmW x 274mmH x 410mmD)
- **Rack Information**: 7U required. The XRP is .25" larger than 6U. In a 7U space there will be 1.5" (38.1 mm) of space above the unit. Requires optional Rackmount shelf (Part 63528).
- **Certifications**: FCC Class A, CE, ROHS, WEEE, UL, UL-C, CE
- **Warranty**: One year return-to-depot
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort ................................................................. 21</td>
</tr>
<tr>
<td>Audio Project .................................................. 14</td>
</tr>
<tr>
<td>AUDIO_TS ...................................................... 14, 26</td>
</tr>
<tr>
<td>Backup Project ................................................. 22</td>
</tr>
<tr>
<td>Blu-ray ........................................................... 1, 2</td>
</tr>
<tr>
<td>BDR ................................................................. 1, 2</td>
</tr>
<tr>
<td>Calibrate Disc Publisher .................................... 36</td>
</tr>
<tr>
<td>Center Print Image .......................................... 36</td>
</tr>
<tr>
<td>Color Matching ............................................... 34</td>
</tr>
<tr>
<td>Connections, Rear Panel ................................... 5</td>
</tr>
<tr>
<td>Controls, Front Panel ....................................... 4</td>
</tr>
<tr>
<td>Change Robot .................................................. 18</td>
</tr>
<tr>
<td>Closed Disc .................................................... 19</td>
</tr>
<tr>
<td>Copy Project .................................................... 10, 13</td>
</tr>
<tr>
<td>Cost Estimator ................................................ 35</td>
</tr>
<tr>
<td>Data Project .................................................... 14</td>
</tr>
<tr>
<td>Disc Cover ....................................................... 10, 28</td>
</tr>
<tr>
<td>File System ...................................................... 20</td>
</tr>
<tr>
<td>Gallery ........................................................... 30</td>
</tr>
<tr>
<td>Identifying the Parts ......................................... 4</td>
</tr>
<tr>
<td>Image Project ................................................... 15</td>
</tr>
<tr>
<td>Inner Diameter ................................................ 12, 17, 33</td>
</tr>
<tr>
<td>Input Bin .......................................................... 5</td>
</tr>
<tr>
<td>Internal Blue LED Lights ................................... 40</td>
</tr>
<tr>
<td>iTunes .............................................................. 25</td>
</tr>
<tr>
<td>Kiosk Setup ...................................................... 9</td>
</tr>
<tr>
<td>LED Status Lights ............................................ 5</td>
</tr>
<tr>
<td>Media Type ....................................................... 2, 48</td>
</tr>
<tr>
<td>New Project Panel ............................................. 11</td>
</tr>
<tr>
<td>Outer Margin ................................................... 12, 17, 33</td>
</tr>
<tr>
<td>Output Bin ........................................................ 5</td>
</tr>
<tr>
<td>Power Input ...................................................... 6</td>
</tr>
<tr>
<td>Print Template ................................................ 23</td>
</tr>
<tr>
<td>Print Quality .................................................... 6, 13, 32</td>
</tr>
<tr>
<td>Printer Tools ..................................................... 34</td>
</tr>
<tr>
<td>PTProtect ......................................................... 18, 26</td>
</tr>
<tr>
<td>Publisher Status .............................................. 21</td>
</tr>
<tr>
<td>Queue Project ................................................... 21</td>
</tr>
<tr>
<td>Recorder Tray .................................................. 4</td>
</tr>
</tbody>
</table>
Recording Speed .................................................................19
Recording Type .................................................................19
Reject Area ........................................................................5, 9
Rip Audio ............................................................................25
Robot Options .....................................................................9
Saturation ............................................................................33
Save Project .........................................................................18
Schedule Project ..................................................................19
Set Time and Date to Mastering Time ...............................20
Span Discs ...........................................................................22
Specifications ......................................................................48
Technical Support ...............................................................47
Test Record .........................................................................20
Transporting the Publisher ..................................................40
Troubleshooting ..................................................................39
Verify ..................................................................................20
Video Project .........................................................................14
VIDEO_TS ...........................................................................14, 26
Windows Media Player ..........................................................25